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Introduction  

The Chromosome Analysis Suite (ChAS) software for cytogenetic analysis enables you to view and summarize 
chromosomal aberrations across the genome. Chromosomal aberrations may include copy number gain or loss, 
mosaicism, or loss of heterozygosity (LOH).  

ChAS provides tools to: 

¶ Perform single sample analysis of CEL files from the Affymetrix
®
 CytoScanÊ HD Array or Cytogenetics 

Whole-Genome 2.7M Array.  

¶ Analyze segment data at different levels of resolution 

¶ View results data (CYCHP files) that summarize chromosomal aberrations in table and graphical formats 

¶ Display CNCHP data from Affymetrix
®
 Genome-Wide Human SNP Array 6.0 

¶ Customize and load your own annotations and regions for focused analysis 

¶ Apply separate filters to the entire genome and user-specified regions of interest to remove irrelevant 
information such as segments in areas that are not of interest 

¶ Perform detailed comparisons between different samples 

¶ Directly access external databases such as NCBI, UCSC Genome Browser, Ensembl, and OMIM 

¶ Generate reports of user-selected data in graphical and tabular formats 

  Important: The results from ChAS are for Research Use Only. Not for use in diagnostic procedures. 

Chromosome Analysis Suite is not a secondary analysis package. However, it does create CYCHP files and tab-
delimited text files required for secondary analysis packages available from companies in the Affymetrix

®
 

GeneChip
®
 Compatible Program. 

About recent  ChAS  Update s  

ChAS 1.2.2 and 1.2.1 contain improved AllelePeaks track data for rare challenging samples, and bug fixes 

ChAS 1.2 includes the following new features and enhancements: 

¶ Genotype calling for Affymetrix
®
 CytoScanÊ HD Array results (page 193), exporting genotype calls (page 

195) 

¶ Status bar displays the NetAffx database build loaded in the ChAS Browser (page 86) 

¶ Load a different NetAffx Genomic Annotations Browser database into the ChAS Browser without 
restarting the software (page 89) 

¶ View sample and results information in the Sample Information window (page 70) 

¶ New Named Settings (page 227) 

¶ Easily identify User Profiles available for import (page 233) 

¶ Apply user-selected colors to reference annotations (except DGV annotations, which contain a pre-
defined set of differential color codes) in the Detail View (page 100) 

¶ Segments table updates: 

o When multiple reference annotations overlap a segment, the genes in the Segments table row are 
listed in the order that they appear from left to right in the Detail View  
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o The ñTypesò column sorts segments in the same order that they appear in the Data Types 
windowpane 

¶ ChAS verifies the hg version of AED or BED files and will not load files with hg version different from that 
currently loaded in the ChAS Browser. If the hg version information is not found in the AED or BED file, 
ChAS warns you before loading the file. 

¶ AED files created in ChAS 1.2 include the hg version 

¶ All loaded AED or BED files are automatically reloaded in a subsequent session with the same user 
profile 

¶ Reports include CytoRegion and Overlap Map file names 

¶ ChAS remembers the destination folder for exported reports for a user profile during a session and in  
subsequent sessions  

 

About this Manual  

This manual provides step-by-step instructions for performing the procedures required to use ChAS. The content 
of this manual is also available in the online help for ChAS. The steps outlining procedures are frequently 
supplemented with screen captures to further illustrate the instructions. The screen captures in this manual may 
not exactly match the windows displayed on your screen. 

Te chnical Support  

Affymetrix provides technical support to all licensed users via phone or E-mail. To contact Affymetrix Technical 
Support:  

AFFYMETRIX, INC. 

3420 Central Expressway 

Santa Clara, CA 95051 USA 

Tel: 1-888-362-2447 (1-888-DNA-CHIP) 

Fax: 1-408-731-5441 

sales@affymetrix.com 

support@affymetrix.com 

 

AFFYMETRIX UK Ltd., 

Voyager, Mercury Park, 

Wycombe Lane, Wooburn Green, 

High Wycombe HP10 0HH 

United Kingdom 

UK and Others Tel: +44 (0) 1628 552550 

France Tel: 0800919505 

Germany Tel: 01803001334 

Fax: +44 (0) 1628 552585 

mailto:sales@affymetrix.com
mailto:support@affymetrix.com


Affymetrix
®
 Chromosome Analysis Suite 1.2.2 User Manual 8 

saleseurope@affymetrix.com 

supporteurope@affymetrix.com 

 

AFFYMETRIX JAPAN K.K. 

Mita NN Bldg. 16F 

4-1-23 Shiba Minato-ku, 

Tokyo 108-0014 Japan 

Tel. 03-5730-8200 

Fax: 03-5730-8201 

salesjapan@affymetrix.com 

supportjapan@affymetrix.com 

mailto:saleseurope@affymetrix.com
mailto:supporteurope@affymetrix.com
mailto:salesjapan@affymetrix.com
mailto:supportjapan@affymetrix.com
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Chapter 1:  Installing  Chromosome Analysis Suite  

Chromosome Analysis Suite (ChAS) is a stand-alone application.  

To process CytoScanÊ HD Arrays and analyze the data, you need to install: 

¶ CytoScanÊ HD Array software for AGCC for processing arrays 

¶ Chromosome Analysis Suite 1.2.2 for data analysis 

¶ Analysis files for data analysis 

 Note: Due to the amount of memory that ChAS needs to operate, Affymetrix very strongly 
recommends that you do not install the ChAS software on production AGCC computers being used 
for scanning and operating fluidics systems. 

This chapter includes: 

¶ Minimum and Recommended Requirements and Prerequisites (below) 

¶ Zip File Contents (page 11) 

¶ Installing ChAS (page 12) 

¶ Installing Analysis Files (page 16) 

¶ Updates and General Information (page 22) 

¶  Setting Proxy Server Access (page 23) 

Minimum and Recommended Requirements and Prerequisite s 

A 64-bit system is recommended for all array types. System requirements are specific for the array type that you 
plan to analyze. 

  Note: Chromosome Analysis Suite requires AGCC 3.2 or higher to produce CytoScanÊ HD CEL files. 

  Note: A 64-bit system is required to generate CytoScanÊ HD CYCHP data files. CytoScanÊ HD 
CYCHP files can be viewed on a 32-bit system. 

Chromosome Analysis Suite has been verified on the following operating systems. ChAS may work on other 
Windows operating systems, but has not been verified on them.  

¶ Operating system on 32-bit 

o Windows 7 Professional with service pack 1 

o Windows XP with service pack 3 

¶ Operating system on 64-bit 

o Windows 7 Professional with service pack 1 

o Windows XP Professional with service pack 2 
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Table 1.1 Minimum operating system and hardware requirements for ChAS software per array type 

Item Array Type 

 CytoScanÊ HD Array Cytogenetics Whole-
Genome 2.7M Array 

Genome-Wide Human 
SNP 6.0 Array 

Processor At least 2 GHz Pentium Dual 
Processor 

At least 2 GHz Pentium 
Dual Processor 

At least 2 GHz Pentium 
Dual Processor 

64-bit Windows 
Operating 
System and Web 
Browser 

Windows 7 Professional SP1 
and Internet Explorer 8.0 or 
above 

or 

Windows XP SP2 and 
Internet Explorer 7.0 or above 

Windows 7 
Professional SP1 and 
Internet Explorer 8.0 or 
above 

or 

Windows XP SP2 and 
Internet Explorer 7.0 or 
above 

Windows 7 Professional 
SP1 and Internet Explorer 
8.0 or above 

or 

Windows XP SP2 and 
Internet Explorer 7.0 or 
above 

32-bit Windows 
Operating 
System and Web 
Browser 

( Data Viewing Only) 

Windows XP SP3 and 
Internet Explorer 7.0 or above 

or 

Windows 7 Professional SP1 
and Internet Explorer 8.0 

Windows 7 
Professional SP1 and 
Internet Explorer 8.0 or 
above 

or 

Windows XP SP3 and 
Internet Explorer 7.0 or 
above 

Windows 7 Professional 
SP1 and Internet Explorer 
8.0 or above 

or 

Windows XP SP3 and 
Internet Explorer 7.0 or 
above 

Disk Space 150 GB HD + data storage* 150 GB HD + data 
storage 

150 GB HD + data storage 

Free Disk Space 
Required at 
Install 

>  5 GB >  5 GB >  5 GB 

RAM 3 GB (32-bit for data viewing 
only) 

8 GB (64-bit) 

3 GB (32-bit) 

8 GB (64-bit) 

3 GB (32-bit) 

8 GB (64-bit) 

CYCHP file 
generated in: 

ChAS 1.2.2, 1.2.1, 1.2 ChAS 1.2.2, 1.2.1, 1.2, 
1.1, 1.0.1 

N/A 

CYCHP file 
viewed in: 

ChAS 1.2.2, 1.2.1, 1.2 ChAS 1.2.2, 1.2.1, 1.2, 
1.1, 1.0.1 

N/A 

CNCHP file 
generated in: 

N/A N/A Genotyping Console 
(GTC) 

CNCHP file 
viewed in: 

N/A N/A ChAS  1.2.2, 1.2.1, 1.2, 
1.1, 1.0.1 

GTC 

*The larger file sizes associated with the CytoScanÊ HD Array should be taken into account when calculating the 
necessary free space requirement. A CytoScanÊ HD Array CYCHP file is ~120 MB. 



Affymetrix
®
 Chromosome Analysis Suite 1.2.2 User Manual 11 

Table 1.2 Recommended operating system and minimum hardware requirements for ChAS software per 
array type 

Item Array Type 

 CytoScanÊ HD Array Cytogenetics Whole-
Genome 2.7M Array 

Genome-Wide Human 
SNP 6.0 Array 

Processor 4 GHz Pentium Quad Core 
Processor 

4 GHz Pentium Quad Core 
Processor 

4 GHz Pentium Quad Core 
Processor 

Windows 
Operating 
System and Web 
Browser 

Windows 7 Professional 
SP1 and Internet Explorer 
8.0 or above 

Windows 7 Professional 
SP1 and Internet Explorer 
8.0 or above 

Windows 7 Professional 
SP1 and Internet Explorer 
8.0 or above 

System  64-bit 64-bit 64-bit 

Disk Space 250 GB HD + data 
storage* 

250 GB HD + data storage 250 GB HD + data storage 

Free Disk Space 
Required at 
Install 

>  5 GB >  5 GB >  5 GB 

RAM 16 GB 16 GB 16 GB 

CYCHP file 
generated in: 

ChAS 1.2.2 ChAS 1.2.2 N/A 

CYCHP file 
viewed in: 

ChAS 1.2.2 ChAS 1.2.2 N/A 

CNCHP file 
generated in: 

N/A N/A Genotyping Console 
(GTC) 

CNCHP file 
viewed in: 

N/A N/A ChAS 1.2.2 

 

* 
The larger file sizes associated with the CytoScanÊ HD Array should be taken into account when calculating the necessary 
free space requirement. A CytoScanÊ HD Array CYCHP file is ~120 MB. 

Zip File  Contents  

There are four items you will need to run the CytoScanÊ HD Array and visualize the data in ChAS 1.2.2. 

¶ 2 AGCC workstation files, from the CytoScanÊ HD product web page at Affymetrix.com 

Á CytoScanHD for AGCC.zip  (see below for instructions) 

Á CytoScanHD Fluidics Script (see array product page for details) 

¶ 2 Data Analysis workstation files, from ChAS product web page (www.affymetrix.com/chas ):  

Á Chromosome Analysis Suite 1.2.2.zip (see below for instructions) 

Á CytoScanHD Analysis Files.zip (see below, or download within ChAS 1.2.2)  
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The ChAS software installer is in a zipped package with several files. 

The zipped package can be downloaded from Affymetrix.com/chas 

After you extract the files from the "Chromosome Analysis Suite 1.2.2.zip" zipped package, there is a folder 
named "Chromosome Analysis Suite 1.2.2".  This folder contains: 

¶ A "64Bit" ChAS installer folder and a "32Bit" ChAS installer folder 

¶ Installation Instructions 

¶ Release Notes 

¶ ChAS User Manual  

The CytoScanHD for AGCC.zip contains files that are required to install the CytoScanHD software on the 
computer running AGCC. 

¶ CytoScanHD_Array.exe 

¶ Pedigree template 

¶ AGCC_CytoScanHD_Install_Instructions.pdf 

Installing ChAS  

  Note: The setup process installs additional required components, which includes Java components 
and Visual C++ runtime. 

  Note: The ChAS 1.2.2 installer supports upgrading from ChAS versions 1.1, 1.2, and 1.2.1.  No 
CytoScanHD Array-specific Library files will be archived during install of ChAS 1.2.2 when upgrading 
from 1.2.1, as the NA32.1 CytoScan HD Array files are appropriate for both 1.2.2 and 1.2.1.  Upgrading 
from 1.2 to 1.2.2 will archive outdated Library files in the ChAS Library folder. 

 

1. In the download of ChAS, the folder contains a 32-bit folder and 64-bit folder.  Select the appropriate folder 
based on your computer (32-bit system or 64-bit system).  Double-click the Chromosome Analysis Suite setup 

icon  on the desktop.  

2.  Follow the directions in the next screen that appears to install the version of Java that ChAS requires. 

  Note:  Starting with ChAS 1.2, the software installs a copy of Java JRE into the program directory for 
its own use. The installation proceeds regardless of whether there are other versions of Java JRE or 
Java SDK installed on your system. Adding or removing other instances of Java will not affect the 
copy of Java JRE in the ChAS program directory. 

3. In the Welcome screen that appears, click Next. 
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Figure 1.1 InstallShield Wizard, Welcome screen 

4. Accept the terms of the license agreement and click Next. 

 

Figure 1.2 InstallShield Wizard, License Agreement screen 

5. In the next screen that appears, click Next to begin the installation. 
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 Figure 1.3 InstallShield Wizard, Ready to Install the Program screen 

6. Click Yes in the message that appears to continue with the installation.  

 

 

Figure 1.4 Notification that outdated ChAS files will be archived 

7. Put a check mark in the check box to confirm that you will obtain the new library files that ChAS requires to 
open CYCHP and CNCHP data files. Click Next. 
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Figure 1.5  Confirm that you will obtain the required library files 

8. If installing the 32-bit version of the software, the following screen appears. Acknowledge that you have read 
the information by putting a check mark in the check box, then click Next. 

 

Figure 1.6 Notification for 32-bit workstations 

9. When the install is complete, click Finish. 
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Figure 1.7  Installation complete 

Un -install ing ChAS  

1. From the Windows Start Menu, select Settings > Control Panel. 

2. Select Add or Remove Programs. 

3. Select Chromosome Analysis Suite in the programs list. 

4. Click the Change/Remove button and following the on screen directions. 

  Note: You can also uninstall ChAS by running the installation file. 

Installing Analysis  Files  

You need to install the required analysis files, also known as library files, before using ChAS. 

This section covers: 

¶ Analysis File Locations, below 

¶ Analysis File Download (page 20) 

¶ Copying Analysis Files (page 22) 

Analysis  File Locations  

To see the location of the analysis files: 

¶ From the Help menu, click Abouté 

or 

¶ Click the About  button in the main toolbar. 

The About this Software screen opens. At the bottom it displays the path and location for the library files and 
preference files. 
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Figure 1.8 About Chromosome Analysis Suite screen 

  Note: The location of the files is different in Windows XP and Windows 7. 

For Windows XP: 

¶ Library: C:\Documents and Settings\All Users\Application Data\Affymetrix\Chromosome Analysis Suite\Library 

¶ Preferences: C:\Documents and Settings\All Users\Application Data\Affymetrix\Chromosome Analysis 
Suite\users 

For Windows 7: 

¶ Library: C:\ProgramData\Affymetrix\Chromosome Analysis Suite\Library 

¶ Preference file: C:\ProgramData\Affymetrix\Chromosome Analysis Suite\preferences.xml 

¶ All other user profile related preference files and saved settings: C:\ProgramData\Affymetrix\Chromosome 
Analysis Suite\users 

The ChAS analysis and preference files may be placed in folders and files that are normally hidden from the user 
in Windows. 

To display hidden files and folders in Windows XP: 

1. From the Start button, select Settings > Control Panel. 

The Control Panel window opens. 

2. Double-click Folder Options icon in Control Panel.  

The Folder Options dialog box opens. 
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Figure 1.9 Folder Options dialog box 

3. On the View tab, under Hidden files and folders, click Show hidden files and folders.  

Hidden files and folders are dimmed to indicate they are not typical items.  

If you know the name of a hidden file or folder, you can search for it.  

To display hidden files and folders in Windows 7: 

1. In the Start menu, click Control Panel. 

The Control Panel window opens. 

2. Click Appearance and Personalization in Control Panel. Under Folder Option, click ñShow hidden files and 
foldersò. 
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Figure 1.10  Control Panel 

3. In the Folder Options dialog box that appears, click the View tab. Under Hidden files and folders, click Show 
hidden files and folders.  

Hidden files and folders are dimmed to indicate they are not typical items. If you know the name of a hidden 
file or folder, you can search for it. 
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Figure 1.11  Folder Options dialog box 

Analysis  File Dow nload  

When you start ChAS for the first time, you will be prompted to: 

1. Create a user profile (see Creating and Using User Profiles, page 229). 

2. Download the library files from NetAffx that ChAS uses to analyze and annotate the data. 

  Note: To process the CytoScanÊ HD Array in AGCC, you will also need to install the appropriate 
analysis files for AGCC (see the specific array product page at www.affymetrix.com for details). 

To download the ChAS analysis files: 

1. Create a NetAffx account with a user name and password (go to www.affymetrix.com and click ñRegisterò at 
the top of the page). 

2. Start ChAS. 

If no annotations are installed, the Download Annotations notice appears.  

http://www.affymetrix.com/
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Figure 1.12  Download Annotations notice 

3. Click Yes. 

The NetAffx Authentication dialog box opens. 

 

Figure 1.13  NetAffx Authentication dialog box 

  Note: You can also open the NetAffx Authentication dialog box by selecting ñUpdate Library and 
Annotation Filesò from the Help menu. 

4. Enter your NetAffx user name and password and click Next. 

The Choose Files dialog box opens with a list of library files that your local hardware can support. Some array 
types require more memory or processing power. If your hardware does not meet the power requirements, 
the library files for that array will not appear. 
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Figure 1.14  Choose Files dialog box 

5. Select the library and annotation files you wish to download. 

You can choose Select All to download all the available files. 

6. Click Next. 

The Download Progress dialog box displays the progress of the downloading and unpacking of the files. 

7. Click Finish when the download is complete. 

Copying Analysis  Files  

If you are unable to connect to the Internet to download the analysis files, copy the contents from the Analysis 
Files folder to the following location: 

¶ If using Windows XP copy the files to: 

C:\Documents and Settings\All Users\Application Data\Affymetrix\Chromosome Analysis Suite\Library 

¶ If using Windows 7, copy the files to: 

C:\ProgramData\Affymetrix\Chromosome Analysis Suite\Library 

See Analysis File Locations (page 16) for more information on the location of the library files and on making 
hidden folders visible. 

Updates and General Information  

New information about Chromosome Analysis Suite (ChAS) is available to customers through the Update Button 
on the main ChAS tool bar. There are three different options: Updates Available, No New Updates, or Updates 
(Offline). 
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Indicates updated information is available. Click the button to launch a web browser 
which indicates the new information that is available. Clicking this button merely 
provides you with a link to information; it does not cause any new software or files to be 
installed or any existing files to be modified. 

 
Indicates there is no new updated information available. Clicking the button will launch 
a web browser that shows the current informational messages. 

 
Indicates that the computer is offline and ChAS is unable to determine if there are any 
updates available. 

Setting Proxy Server Access  

This configuration should only be done if the userôs system has to go through a proxy server to access Affymetrix 
NetAffx server. 

In most cases when a customer needs to use a proxy they can just set a system-level proxy on their machine 
using their default browser and and leave the settings inside ChAS on the default choice Use System Proxy. 

 Please contact your IT department if you do not know what proxy settings you need. 

To set the Proxy Server Access in ChAS: 

1. From the Preferences menu, select Edit Application Configurationé. 

 

Figure 1.15 Preferences menu, Edit Application Configurationé 

The Configuration dialog box opens (Figure 1.16). 
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Figure 1.16 Configuration dialog box 

By default it has the Use System Proxy option selected. 

2. Select Use Custom Proxy and enter the Host and Port information (Figure 1.17). 

 

Figure 1.17 Configuration dialog box with custom proxy information 

3. Click OK. 

When ChAS needs to connect with the internet, a dialog box may ask for the credentials (Figure 1.18). 

 

Figure 1.18 Credentials dialog box 
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This can happen when: 

¶ The software is started. 

¶ You request an update for the software and annotation files. 

4. Enter the credentials for the proxy server and click OK. 

  Note: This proxy user id and password is not the same ID and password used to connect to the 
Affymetrix NetAffx server. 
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Chapter 2:  Getting Started with Chromosome Analysis Suite  

This chapter provides some context for using ChAS. It covers: 

¶ Starting Chromosome Analysis Suite (below) 

¶ File Types and Data Organization in Chromosome Analysis Suite (page 28) 

¶ Basic Workflow for Cytogenetics Analysis (page 30) 

¶ Working with ChAS (page 34) 

Starting Chromosome Analysis Suite  

To start Chromosome Analysis Suite: 

1. Double-click the ChAS icon  on the desktop. 

Alternatively, from the Windows Start Menu, select Programs > Affymetrix > Chromosome Analysis Suite 
> Chromosome Analysis Suite. 

The ChAS splash screen and the Select User dialog box open. 

 

Figure 2.1  Splash screen and Select User dialog box 

2. Select or create a User Profile (see Creating and Using User Profiles, page 229). 

3. Click OK. 

The Chromosome Analysis Suite opens. 
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Figure 2.2   Chromosome Analysis Suite when first opened 

The ChAS window has the following components: 

¶ Menu Bar ï Provides access to the functions of the software 

¶ Tool Bar ï Provides quick access to commonly used functions 

¶ Files List (page 84) ï Shows the data and annotation files that are available for display 

¶ Data Types List (page 85) ï Displays the type of data available in the files. 

¶ Named Settings (page 86) ï Displays a list of the previously saved display settings for ChAS. 

¶ Status Bar (page 86) ï Displays information on the status of the software, the ChAS Browser NetAffx 
Genomic Annotation file version, the hg version, information about the annotation or probe that the mouse 
pointer is nearest to in the Detail View, and the user profile name 

¶ Display Area (page 87) ï Displays the following data in graphical and table formats: 

¶  CYCHP and CNCHP marker data 

¶ Detected segments 

¶ Region information file data 

¶ Reference annotations 

¶ Status Bar ï Displays information on the status of the software, as well as the NetAffx version and hg version 
of the currently loaded NetAffx Genomic Annotation file. 

See Viewing Data in ChAS  (page 82) for more information. 

Karyoview in  
Upper Display Area 

Detail View in  
Lower Display Area 

Files List 

Data Types List 

Selected chromosome view 

Se 

Named 
Setting 

Menu Bar 

Tool Bar 

Status bar 
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The Analysis Manager  

The Analysis Manager tracks ongoing analysis tasks for ChAS and alerts you when the computer does not have 

sufficient memory to perform an analysis. When the Analysis Manager is running, it is indicated by an icon  in 

the right side of the Windows taskbar.  

 

Figure 2.3   Analysis Manager icon in the Windows task bar 

To open the Analysis Manager: 

¶ Right-click the Analysis Manager icon  and select Status. 

The Analysis Manager Status window opens. 

 

Figure 2.4   Analysis Manager 

See Using the Analysis Manager (page 54) for more information. 

File Types and Data O rganization in Chromosome Analysis Suite  

To fully use the capabilities of ChAS, you need to understand the ChAS file types and data organization in ChAS. 

Chromosome Analysis Suite  File Types  

ChAS uses the following types of files. 

¶ Data files 

¶ Region Information files 

¶ Support files 
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Files Types Supported in ChAS 

Some of the data files that ChAS uses are generated by other Affymetrix software.  

Table 2.1 File types used by ChAS 

File Type Created In ChASé 

Sample file (ARR) AGCC Uses this information to associate sample attribute 
information with CEL and CYCHP or CNCHP files. 

Intensity Data file (CEL) AGCC Analyzes the intensity data and generates a CYCHP 
file. 

Note: A 64-bit system is required to analyze 
CytoScanÊ HD intensity data. 

Analysis Results (CYCHP) 

CytoScanÊ HD array: 
CYCHP contains copy 
number, LOH, and 
genotype call information 

Cytogenetics Whole-
Genome 2.7M  arrays: 
CYCHP includes copy 
number, LOH, and 
mosaicism information 

ChAS Displays results in graphical and tabular formats. 

CopyNumber/LOH 
(CNCHP) 

GTC Can open this file and display probe-level analysis 
data and generate segment data on-the-fly. 

Region Information File 
(BED or AED) 

ChAS or 
Text Editor 

Allows users to display their own custom data and 
optionally use the information to define CytoRegions 
or an Overlap Map. ChAS can export data in BED 
format for use with the UCSC Browser and other 
programs which understand this format. 

Tab-separated values 
(TSV, TXT) 

ChAS Exports data in this format for use in a spreadsheet 
program or other user-defined uses. This format is 
for export only. ChAS does not import TSV or TXT 
files. 

 

Region Information Files 

The region information files in Browser Extensible Data (BED) and Affymetrix Extensible Data (AED) format 
provide lists of regions in the genome with position information and other annotations. To open a BED or AED file, 

click the  button or select File > Open on the menu bar. All BED or AED files that are opened during a session 
will reload when you start a new session with the same user profile.  

  Note: You can also use the reference annotations to provide region information. 

  Note: You can use the Export feature to export data in existing BED files to an AED file. See 
Exporting Information in AED or BED Format (page 176).  
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Support files 

The support files are necessary to use all of the features of ChAS.  

¶ Library file sets with files for Copy Number/LOH/Mosaicism analysis (Analysis files) 

¶ Reference Model files for single sample Copy Number/LOH/Mosaicism analysis of Intensity Data files (CEL) 
from CytoScanÊ HD Arrays and Cytogenetics 2.7M Arrays (downloaded with other Analysis files or 
generated in ChAS) 

¶ Reference Annotation files (Browser Annotation files named with the following format: 
<NetAffxGenomicAnnotations.Homo_sapiens.hgxx.naxx.db>) 

Data Organization in ChAS  

ChAS allows you to keep your CEL and CYCHP files in any folder on your computer, instead of being kept in a 
workspace. As long as you know where the files are, you can load them from anywhere and move them around at 
your convenience.  

  Important: Affymetrix recommends that you perform analysis operations with all files stored on a 
local disk drive. 

Basic Workflow for Cytogenetics Analysis  

 Important: The results from ChAS are for Research Use Only. Not for use in diagnostic procedures. 

 Note: When referring to steps that apply to both CYCHP and CNCHP files, the term ñCxCHPò is used. 

ChAS can be used to: 

¶ Perform probe-level analysis of CEL file data for CytoScanÊ HD Arrays and Cytogenetics Whole-Genome 
2.7M Arrays 

¶ Display probe-level analysis data  (CxCHP) from: 

¶ CytoScanÊ HD Arrays (CYCHP) 

¶ Genome-Wide Human SNP Array 6.0 (CNCHP) 

¶ Cytogenetics Whole-Genome 2.7M Arrays (CYCHP) 

There are some differences in the way the ChAS handles these three types of arrays and how it treats the 
data from these two types of files.  

The basic cytogenetic analysis workflow includes the following steps: 

1. Array Processing Workflow, done in AGCC (see below). 

2. Probe Level Analysis of CEL file data (page 31). 

¶ For the CytoScanÊ HD Array or Cytogenetics Whole-Genome 2.7M Array, this analysis is performed in 
ChAS and produces CYCHP files (See CN/LOH/Mosaicism Analysis on page 37). 

 Note: A 64-bit system is required to analyze CytoScanÊ HD array CEL files. 

¶ For the Genome-Wide Human SNP Array 6.0, this analysis is performed in Genotyping Console (GTC) 
software and produces CNCHP files (see the GTC User Guide). 

3. Load CNCHP and CYCHP data into ChAS for display (page 32). 

4. View the data using the ChAS display controls to find features of interest (page 33). 
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Array Processing  Workflow  

Array processing is performed in AGCC 3.2 or higher for the CytoScanÊ HD  Array, Genome-Wide Human SNP 
6.0 Array, and Cytogenetics Whole-Genome 2.7M Array. 

  Note: You need to have the appropriate AGCC library files installed to perform these analyses for the 
different array types. 

The array processing includes the following steps: 

1. Registering samples and arrays 

2. Performing fluidics processing on arrays 

3. Scanning arrays and generating intensity (CEL) file data. 

The following file types are produced: 

¶ Sample (ARR files) (AGCC only) 

¶ DAT Files 

¶ CEL Files 

See the AGCC Userôs Guide for more information. 

Probe -Level Analysis  

Cytogenetic analysis data is handled differently from genome-wide genotyping data in this step. 

  Note: You need to have the appropriate ChAS library files installed to perform these analyses for 
different array types. A 64-bit system is required to analyze CytoScanÊ HD CEL files. 

¶ CytoScanÊ HD Array or Cytogenetics Whole-Genome 2.7M Array Data: The probe level analysis on CEL 
file data is performed in ChAS and produces CYCHP files which contain the data shown in Table 2.2. See 
CN/LOH/Mosaicism Analysis (page 37). 

¶ Genome-Wide Human SNP Array 6.0 Data: The probe level analysis on CEL file data is performed in 
GTC and produces the data shown in Table 2.2. CNCHP files. See the GTC User Guide for more 
information. 

Table 2.2 Analysis results data by array type  

 Analysis Results
1
 

 CytoScanÊ 
HD Array

2
 

Cytogenetics 
Whole-Genome 
2.7M Array

3
 

Genome-Wide 
Human SNP 
Array 6.0

4
 

Graph Data for the individual 
CN and SNP probes 

   

Copy Number State yes yes yes 

Log2 Ratio yes yes yes 

Weighted Log2 Ratio yes yes no 

LOH yes yes yes 

Allele Peaks yes yes no 
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Allele Difference no no yes 

Genotype Calls yes no no 

Smooth Signal yes yes yes 

Segment data    

Gain and Loss segments 
based on Copy Number State 
data based on runs of 
aberrant Copy Number State 
data 

yes yes yes 

Mosaicism segments of non-
integer Copy Number States 
between CN=1 and CN=3 

no yes no 

LOH (Loss of Heterozygosity) 
based on runs of SNPs where 
heterozygote calls are absent 

yes yes yes 

1CYCHP for CytoScanÊ HD Array or Whole-Genome Cytogenetics 2.7M Array. CNCHP for Genome-Wide Human SNP 6.0 
Array.  

2
For more details on CytoScanÊ HD Array data, see Table 6.1 on page 100. 

 
3
For more details on Cytogenetics Whole-Genome 2.7M Array data, see Table 6.2 on page 101. 

 
4
For more details on Genome-Wide SNP Array 6.0 data, see Table 6.3 on page 102. 

Loading CYCHP or CNCHP Data  

You perform the same steps for the different types of array data (CYCHP or CNCHP), but ChAS handles the two 
types of data differently. 

CytoScanÊ HD Array or Cytogenetics Whole-Genome 2.7M Array (CYCHP files) 

When loading CYCHP files into ChAS for viewing, the software: 

1. Selects the run-length encoded segments in the CYCHP file to display as segments.  

2. Applies any smoothing or joining that would alter the length and other properties of segments. 

3. Displays the segments and graph data: 

¶ Segment Data 

o Copy Number Gain/Loss 

o Loss of Heterozygosity (LOH) 

o Mosaicism (for Cytogenetics Whole-Genome 2.7M CYCHP only) 

¶ Graph Data 

o Copy Number State 

o Log2Ratio 

o Weighted Log2Ratio 

o Smooth Signal 

o Loss of Heterozygosity (LOH) 
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o Allele Peaks 

o Genotype calls (for CytoScanÊ HD CYCHP only) 

Genome-Wide SNP Array 6.0 (CNCHP files) 

When loading CNCHP files into ChAS for viewing, the software: 

1. Performs segment generation by analyzing the CN and LOH graph data in the CNCHP file. 

2. Applies any smoothing or joining that would alter the length and other properties of Copy Number segments. 

In GTC software, these steps were performed in the Segment Reporting Tool. 

3. Displays the segments and graph data: 

¶ Segment data  

o Copy Number Gain/Loss 

o Loss of Heterozygosity (LOH) 

¶ Graph Data 

o Copy Number State 

o Log2 Ratio 

o Allele Difference 

o SmoothSignal 

o Loss of Heterozygosity (LOH) 

Viewing Data  

ChAS provides several options for viewing and studying the loaded CYCHP or CNCHP data: 

¶ Graphic Displays  

See Displaying Data in Graphic Views (page 90). 

¶ Tables  

See Displaying Data in Table Views (page 179). 

After the data is loaded, you can: 

¶ Filter the segments by Segment Parameters to hide segments that do not meet your requirements for 
significance. 

See Filtering Segments (page 131) 

¶ Select a region information file for use as a CytoRegion file and: 

¶ Perform differential filtering for segments in CytoRegions and in the rest of the genome. 

¶ Display only segments that appear in CytoRegions using Restricted Mode. 

See Using CytoRegions (page 135). 

¶ Select a region information file for use as an Overlap Map and use the Overlap filter to identify or conceal 
segments that appear in the Overlap Map regions. 

See Using the Overlap Map (page 145). 

¶ Add selected features of the genome to new or existing Region (AED) files, and edit annotation data on 

existing annotations. (To open a BED or AED file, click the  button or select File > Open on the menu bar.) 

See Creating and Editing AED Files (page 153). 
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¶ Prepare reports on your findings by exporting graphics and table data in PDF and other formats. 

See Reporting Results (page 208). 

¶ Save setups of ChAS for different tasks in user profiles and named settings. 

See User Profiles and Named Settings (page 227). 

Working w ith ChAS  

This section covers: 

¶ Accessing Functions in ChAS  (page 34) 

¶ Changing the Size of Panes in ChAS  (page 34) 

¶ Opening Panes in Separate Windows (page 35) 

Accessing Functions in ChAS  

Commands in ChAS can be accessed in multiple ways. You can access commands from: 

¶ Main menus 

¶ Toolbar 

¶ Right-click options in the: 

¶ Files list 

¶ Data Types list 

¶ Karyoview 

¶ Selected Chromosome View 

¶ Detail View 

¶ Table headers 

The alternatives for a particular function are described in the step-by-step instructions for using the function. 

Changing the Size of Panes in ChAS  

You can change the size of the panes in the ChAS window: 

¶ Click and drag the dividers between panes 

¶ Click the arrows in the dividers (  or ) to hide or maximize an entire pane 
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Figure 2.5   Resize or show/hide panes 

Opening Panes in Separate Windows  

You can display a pane in a separate window by clicking the   icon on the tab. To close the window and return 

the information to the tab panel, click the    icon in the window.  

Click arrows to 
show/hide a pane 

Drag a divider to 
resize a pane 
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 Figure 2.6   Graphs pane opened in new window 
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Chapter 3:  CN/LOH/ Mosaicism Analysis  

ChAS analyzes the intensity data (CEL file) from CytoScanÊ HD Arrays or Cytogenetics Whole-Genome 2.7M 
Arrays. The software performs a single sample analysis which compares the data in a CEL file to a previously 
created reference file, using analysis parameters specified in the .chasparam file. The analysis generates a 
CYCHP data file that you load and view in ChAS. The analysis detects segments that exhibit: 

¶ Copy number state gain or loss ï Regions of integer copy number gain or integer copy number loss  

¶ Mosaicism ï Regions of non-integer copy number gain or loss (CN states between 1 and 3)  

  Note: Mosaicism analysis is currently only available for Cytogenetics Whole-Genome 2.7M CEL 
files. However, CxCHP files for the other array types contain the SmoothSignal data type which 
displays non-integer copy number changes. 

¶ Loss of Heterozygosity (LOH) ï Regions where the preponderance of SNPs do not display heterozygosity 

For more details on loading and viewing CYCHP data, see Loading Data (page 67). 

 Important: The results from ChAS are for Research Use Only. Not for use in diagnostic procedures. 

 Affymetrix provides .chasparam and reference files. You can also create your own reference file or set custom 
analysis parameter values.  

  Note: You can also load Genome-Wide Human SNP Array 6.0 CNCHP files into ChAS to display and 
detect Copy Number and Loss of Heterozygosity segments. See Loading Data (page 67). 

  Important: Affymetrix recommends that you perform analysis operations with all files stored locally. 

This chapter explains how to: 

¶ Perform single sample analysis (page 37) 

¶ Create a reference file (page 49) 

¶  Use the Analysis Manager (page 54) 

¶ Customize and manage analysis parameters (page 58) 

Single Sample Analysis  

Single Sample Analysis compares the values in one or more user-selected CEL files with the values in a 
reference file that is created from a set of sample files. You can use the factory-loaded reference file provided by 
Affymetrix or create your own (for more details, see Creating a Reference File on page 49). 

This section covers: 

¶ ChAS and NetAffx Analysis File Compatibility (below) 

¶ Performing Single Sample Analysis (page 43) 

ChAS and NetAffx Analysis File Compatibility  

Table 3.1 lists the compatibility between ChAS and NetAffx Analysis file versions for the CytoScanÊ HD Array 
and the Cytogenetics Whole-Genome 2.7M Array. 

  Note: ChAS automatically prevents you from selecting an incompatible NetAffx Analsis file version 
for analysis or when viewing analysis results. 



Affymetrix
®
 Chromosome Analysis Suite 1.2.2 User Manual 38 

Table 3.1 Compatibility between ChAS version and NetAffx analysis file set version 

 ChAS Software Version 

 ChAS 1.2.2 
and 1.2.1 

ChAS 1.2 ChAS 1.1 ChAS 1.0.1 ChAS 1.0 

CytoScanÊ HD Array 
NetAffx Analysis File Set 
Version 

     

NA32.1(hg19) Yes No No No No 

NA32(hg19) No Yes No No No 

 

Cytogenetics Whole-
Genome 2.7M Array 
NetAffx Analysis File Set 
Version 

     

NA32(hg19) Yes Yes Yes No No 

NA31(hg19) Yes Yes Yes No No 

NA30.2(hg18) Yes Yes Yes No No 

NA30.1(hg18) No No No Yes No 

NA30(hg18) No No No Yes No 

NA29(hg18) No No No Yes No 

NA28(hg18) No No No No Yes 

 

Intro duction  to Single Sample Analysis  

Single Sample Analysis requires: 

¶ ChAS analysis files for the array 

See Installing Analysis Files (page 16). 

¶ A previously created reference model file 

You can use the reference model file provided by Affymetrix or create your own using your own CEL file data 
and the Reference File creation function. The Reference Model file in the CytoScan HDÊ Array set of NA32 
Analysis includes 380 microarrays which were run as part of a larger set of microarrays by nine operators 
processing ~48 unique samples in two rounds each, with randomization of the placement of sample DNAs 
across the PCR plates and randomization of the reagents and instruments used. The source DNA includes: 

o 284 HapMap samples including at least one replicate of each of 270 HapMap samples: 90 from each 
of the Yoruban, Asian, and Caucasian ethnic groups, from cell-line derived DNAs from the Coriell 
Institute of Medical Research 
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o 96 DNA samples from blood of phenotypically healthy male and female individuals obtained from 
BioServe Biotechnologies 

¶ CEL file data 

During the analysis, ChAS generates CYCHP files with: 

¶ Graph Data 

¶ Copy Number State 

¶ Log2 Ratio 

¶ Weighted Log2 Ratio 

¶ LOH 

¶ Allele Peaks 

¶ Smooth Signal 

¶ Segment Data 

¶ Copy Number Gain/Loss 

¶ Mosaicism (currently available for Cytogenetics Whole-Genome 2.7M Array) 

¶ Loss of Heterozygosity (LOH) 

The CYCHP files can be loaded into ChAS for viewing and study. 

Figure 3.1 shows an overview of single sample analysis for the CytoScanÊ HD Array.  
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Figure 3.1 CytoScanÊ HD single sample analysis 
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Copy Number Segments on the X and Y Chromosomes 

The expected copy number state on the X chromosome in normal males is not constant over its entire length. 
This is due to the structure of the sex chromosomes, and the fact that they share extensive homology with each 
other only in the Pseudo Autosomal Regions (PARs) that they each have at either end. PAR1 is at the top of the 
p-arm and PAR2 at the bottom of the q-arm.  

Markers occurring in the PAR regions are mapped exclusively to the X Chromosome. Therefore, in normal males 
the PAR regions of the X are expected to be CN=2 (probes on the X and Y contribute to the signal), while the rest 
of the Chr X is expected CN=1 for normal males. As a result, we treat the two X PARs in males as independent 
units (CN=2 expected) from the rest of the X chromosome (CN=1 in males) when generating Copy Number 
Segments. 

Aberrant segments that cross PAR/non-PAR boundaries may be normalized into one segment if they have 
equivalent type (Gain or Loss) and CN State. During this normalization process, ChAS will not combine an 
aberrant (Gain or Loss) segment with a normal segment across PAR/non-PAR boundaries, even if they have the 
same CN State. If smoothing is subsequently applied, aberrant segments with different copy number state may be 
combined. If joining is subsequently applied, aberrant segments separated by a non-aberrant segment may be 
combined. 

Because only Y-specific probes are mapped to the Y chromosome, the expected state of the entire Y 
chromosome is 1 for males and is 0 for females. 

LOH Segments on the X and Y Chromosomes  

CytoScanÊ HD Array 

For normal XY male samples, the X chromosome will have single-copy based LOH calls (CN = 1). Male samples 
with more than one X chromosome (for example, XXY) may have LOH calls on the X chromosome, depending on 
the constitution of the X chromosomesô origins. 

Table 3.2, Table 3.3, and Table 3.4 briefly describe how the array-specific algorithms call LOH segments for the X 
or Y chromosome.  
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Table 3.2 Expected LOH calls on the X and Y chromosomes for the CytoScanÊ HD Array 

 X Chromosome Y Chromosome 

Normal male sample (XY) LOH calls that are single copy-based 
LOH call (CN = 1). 

No LOH calls are made for the Y 
chromosome. Genotype calling is 
not performed on the Y 
chromosome. Male sample with multiple X 

chromosomes (for example, 
XXY) 

LOH calls are possible, depending on 
the constitution of the X chromosomesô 
origins. 

Normal female sample (XX) LOH calls are possible, depending on 
the constitution of the X chromosomesô 
origins. 

 

Female sample with a 
single X chromosome (X0) 

LOH calls on X regions which have 
only a single copy. Heterozygous SNP 
genotypes are possible, but are due to 
the low inherent Heterozygote call 
error rate noise, not the true presence 
of two alleles. 

 

 

Table 3.3 Expected LOH calls on the X and Y chromosomes for the Genome-Wide Human SNP Array 6.0 

 X Chromosome Y Chromosome 

Normal male sample (XY) LOH calls on the non-PAR region of 
the X chromosome resulting from 
ñforcedò homozygote-only calls due to 
the presence of the Y chromosome. 

Heterozygous calls are ignored on the 
X chromosome in males. 

LOH calls that are due to single 
copy genotyping calls (CN = 1). 

Male sample with multiple X 
chromosomes (for example, 
XXY) 

LOH calls are possible, depending on 
the constitution of the X chromosomesô 
origins. 

SNP genotypes are not constrained to 
homozygous calls. Heterozygous calls 
are ignored on the X chromosome in 
males. 

Normal female sample (XX) LOH calls are possible, depending on 
the constitution of the X chromosomesô 
origins. 

LOH analysis is not performed on 
the Y chromosome since it is 
assumed that there not substantial 
Y chromosomal material. 

Female sample with a 
single X chromosome (X0) 

LOH calls on X regions with only a 
single copy. Heterozygous SNP 
genotypes are possible, but are due to 
the low inherent Heterozygote call 
error rate noise, not the true presence 
of two alleles. 



Affymetrix
®
 Chromosome Analysis Suite 1.2.2 User Manual 43 

 

Table 3.4 Expected LOH calls on the X and Y chromosomes for the Cytogenetics Whole-Genome 2.7M 
Array 

 X Chromosome Y Chromosome 

Normal male sample (XY) LOH calls that are single copy-based 
LOH call (CN = 1). 

LOH Analysis is not performed 
because there are no SNP probes 
mapped to the Y chromosome for 
this array Male sample with multiple X 

chromosomes (for example, 
XXY) 

LOH calls are possible, depending on 
the constitution of the X chromosomesô 
origins. 

Normal female sample (XX) LOH calls are possible, depending on 
the constitution of the X chromosomesô 
origins. 

LOH Analysis is not performed 
because there are no SNP probes 
mapped to the Y chromosome for 
this array 

Female sample with a 
single X chromosome (X0) 

LOH calls on X regions which have 
only a single copy.  

 

Performing Single Sample Analysis  

1. From the Analysis menu, select Single Sample Analysisé 

The Single Sample Analysis dialog box opens. 

 

Figure 3.2 Single Sample Analysis 

2. Select CytoScanÊ HD Array from the Array Type drop-down list. 
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  Note: The ñSelect the array typeò drop-down list includes only the array types for which library 
(analysis) files have been downloaded from NetAffx or copied from the Library package provided 
with the installation.  

The analysis parameter file, reference file, and annotation file drop-down lists are automatically filtered after 
you choose an array type. 

 

Figure 3.3 Drop-down lists that are automatically filtered after you select the array type 

3. Select an analysis parameter file from the drop-down list.  

You can click View Parameters to display all of the parameters in the parameter file. 
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Figure 3.4 Analysis parameters for CytoScanÊ HD array 

Click a parameter to display a short description in the Description box at the bottom of the window. 

See Analysis Parameters (page 235) for more information about the parameters that you can adjust. 

  Important: The analysis algorithm uses different terms to identify the parameters. You may see these 
terms in various error messages.  

4. Select a reference file from the drop-down list. For more details on creating a reference file, see page 49. 

5. Select an annotation file from the drop-down list.  

  Note: The analysis must use the same annotation file that was used to create the reference model. 

6. Select the CEL files for analysis. 

a. Click Add. 

The Open dialog box appears. 
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Figure 3.5 Open dialog box 

b. Navigate to the folder with the CEL file(s) that you want to analyze. 

c. Select the CEL file(s) to be analyzed. 

 Note: You can load several CEL files at a time for a Single Sample Analysis. ñSingle Sample 
Analysisò refers to comparing one sample at a time against a reference model. 

d. Click Open. 

The files appear in the intensity file list. 

 

Figure 3.6 CEL files for the analysis 

To remove a file from the list, select a file in the box and click Remove. 
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The total number of selected files is displayed below the box. 

7. Select a folder for the output files. 

 

Figure 3.7 Output folder location 

Enter a path to the output folder. Alternatively, 

a. Click the Browse button . 

The Select Output Folder dialog box opens. 

 

Figure 3.8 Select Output Folder dialog box 

b. Navigate to the folder where you want to save the resulting CYCHP files... 

You can also create a new folder (click the  button). 

c. Click Save. 
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8. Enter a suffix to be added to the output file names (optional). 

Adding a suffix to the CYCHP file name may help track results, for example, if you reanalyze CEL files using 
different parameters. 

 Important: If you previously analyzed the selected CEL files and are saving the new CYCHP files to the 
same location as the previous files, you need to add a unique suffix to the new files, otherwise the 
original CYCHP files will be overwritten. 

 

Figure 3.9 Suffix field 

9. Click OK to begin the analysis. 

If there are no errors, the analysis proceeds and the following notice appears. 

 

Figure 3.10 Analysis job message 

The software automatically checks the memory available for the analysis using the Analysis Manager (page 
54). 

You can track the progress of the analysis in the Analysis Manager. For more details, see Tracking the 
Progress of an Analysis, page 55. 
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Creating a Reference File  

This section explains how to create a reference file which is required to perform single sample analysis in ChAS. 
The software analyzes a sample file by comparing it to a reference file. You can use the reference file provided 
with ChAS, or you can create a reference file using your own sample data.  

Figure 3.11 shows an overview of the analyses involved in creating a reference file for the CytoScanÊ HD Array. 

 

Figure 3.11 Overview of creating a reference file 
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To create a reference file: 

 Note: When creating a reference file, it is recommended that you use a minimum of 44 CEL  
files, with at least 20 files from male and 20 from female samples. 

1. Select Analysis > Create Reference on the menu bar.  

The Reference File Creation dialog box opens. 

 

Figure 3.12 Reference File Creation dialog box 

2. Select an array type from the array type drop-down list. 

The analysis parameter file and annotation files are automatically selected based on the selected array type. 
You can click View Parameters to display all the parameters in the parameter file. 
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Figure 3.13 Drop-down lists automatically filtered by array type 

 

Figure 3.14 Reference file parameters 

3. Put a check mark next to the target preparation method(s) that was used to generate the CEL file data that 
will provide the input to the Reference Creation: Manual or Automated (using a robot). 
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Figure 3.15 Select the type of target preparation 

4. To select the CEL files for analysis: 

a. Click Add. 

The Open dialog box appears. 

 

Figure 3.16 Open dialog box 

b. Navigate to the folder with the CEL files. 

c. Select the CEL files that will be used to create the reference file.   
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    Note: Affymetrix recommends that you use a minimum of 44 CEL files, with at least 20 of each 
gender to create a reference file. 

d. Click Open. 

The files appear in the CEL file list. To remove a file from the list, select the file and click Remove.  

The total number of selected files is displayed below the box. 

 

Figure 3.17 CEL files selected for creating a reference file 

5. Enter a name for the reference file. 

6. Click OK to begin the analysis. 

A warning appears if you selected less than 44 CEL files for creating the reference file. Otherwise, the 
analysis job begins. 

 

Figure 3.18 Warning message 
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Figure 3.19 Analysis job started 

7. Click OK. 

The software automatically checks the memory available for the analysis using the Analysis Manager (page 
54). 

You can track the progress of the analysis in the Analysis Manager. For more details see page 55. 

Using t he Analysis Manager  

The Analysis Manager tracks ongoing analysis tasks for ChAS and alerts you when the computer does not have 
sufficient memory to perform an analysis. It also delivers the results of analyses and restarts the Browser if it was 
shut down to free up memory for the analysis. 

This section covers: 

¶ Starting an Analysis with the Analysis Manager, below 

¶ Tracking the Progress of an Analysis (page 55) 

¶ Analysis Results Dialog Box (page 57 ) 

Starting an Analysis with the Analysis Manager  

1. Click OK in the Analysis dialog box. 

The following notice appears. 

 

Figure 3.20 Analysis job message 

2. Click OK in the Analysis Job Initiated dialog box. 

If the Analysis Manager does not detect at least 1200 MB of free memory, the following message appears. 
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Figure 3.21 Prompt to close applications 

This message prompts you to close the ChAS window or other applications to provide more memory for the 
analysis. 

3. Close the ChAS window and click Yes to see if enough memory is available.  

Click No to proceed with the analysis without closing any applications. 

You can track the progress in the Analysis Manager window (see below). 

Tracking the Progress of an Analysis  

1. To open the Analysis Manager, double-click the Analysis Manager icon  at the far right of the Windows 

task bar. Alternatively, right-click the  icon and select Status on the shortcut menu that appears.. 

 

Figure 3.22 Analysis Manager in the task tray 

The Analysis Manager Status window appears. 
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Figure 3.23 Analysis Manager with analysis running 

The Analysis Manager Status window has the following components: 

¶ Analysis Queue - Lists jobs that are in progress or waiting for analysis 

¶ Current Analysis Status Messages - Provides status messages, with: 

¶ Time - Time of the message being performed.  

¶ Status Message - Notice about particular step in the analysis 

¶ Cancel Current Analysis - Aborts the analysis that is currently running 

¶ Close - Closes the Analysis Manager Window 

  Important: Closing the Analysis Manager Status window does not stop the current analysis in 
progress or shut down the Analysis Manager. 

To cancel the current analysis: 

¶ Click Cancel Current Analysis. 

If the analysis is already running, it may take a few seconds before the analysis job is cancelled. 

To exit the Analysis Manager and cancel the current analysis: 

1. Right-click the Analysis Manager icon  and select Exit. 
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The following notice appears: 

 

Figure 3.24 Analysis Manager message 

2. Click Yes to exit. 

Any ongoing analysis stops. 

The Analysis Results dialog box opens to display the stopped runs. 

Analysis Results Dialog Box  

The Analysis Results dialog box displays a list of the finished jobs. Failed or canceled jobs are marked with the  
symbol. 

      

Figure 3.25 Completed job (left), failed or canceled job (right) 

The buttons allow you to perform the following tasks: 

¶ Open Results ˈ Opens the folder with results files in the Open dialog box. See Loading Files (page 68)  

¶ View Log ˈ Displays log file with analysis status messages. 

¶ Delete Job ˈ Deletes the selected job from the Analysis Results list. 

To delete a job from the list: 

1. Select the job in the list. 

2. Click Delete. 

The following notice appears. 
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Figure 3.26 Delete Job message 

3. Click Yes to delete the job. 

  Note: This deletes the job, log file, and error file only. It does not delete the results data files. 

Using the Analysis Param eters Functions  

The analysis parameters functions enable you to: 

¶ Create a new analysis parameter file 

¶ Export analysis parameter files 

¶ Import analysis parameter files. 

The configuration file parameters are described in Analysis Parameters (page 235). 

Creating a New Analysis Parameters File (Customizing)  

You can create a new analysis parameters file with different parameters. 

  Note: The CytoScanÊ HD Array does not have user-modifiable analysis parameters. 

1. Select a parameter file to use as a starting point. 

2. Edit the parameter file. 

3. Save the file with a new name 

To create a new parameter file (customizing): 

1. Select Analysis > Customize Analysis Parameters on the menu bar. 

The Create Parameter Set dialog box opens. 

 

Figure 3.27 Create Parameter Set dialog box 








































































































































































































































































































































































































































